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USB4v2 Automated Testing—At a Glance

The Keysight D9050USBC USB4v2 Compliance Test Application allows the testing of PAM3 devices 
with the Keysight Infiniium Oscilloscope.

The current version of the USB4v2 Test Application extends support for symbol rates of 25.6 GBd and 
26.667 GBd.

The USB4v2 Test Application:

• Lets you select individual or multiple tests to run.

• Lets you identify the device being tested and its configuration.

• Shows you how to make oscilloscope connections to the device under test.

• Automatically checks for proper oscilloscope configuration.

• Automatically sets up the oscilloscope for each test.

• Provides detailed information for each test that has been run, and lets you specify the thresholds 
at which marginal or critical warnings appear.

• Creates a printable HTML report of the tests that have been run.

NOTE The tests performed by the USB4v2 Test Application are intended to provide a 
quick check of the electrical health of the DUT. This testing is not a 
replacement for an exhaustive test validation plan.
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Required Equipment and Software

In order to run the USB4v2 automated tests, you need the following equipment and software:

Hardware

• D9050USBC USB4v2 Compliance Test Application software

• Matlab Runtime Compiler MCR R2021b (9.11)

• https://www.mathworks.com/products/compiler/matlab-runtime.html

• USB4 SigTest Tool (minimum required version is 0.75)

• https://www.usb.org/compliancetools#anchor_sigtest

• For more info on minimum system requirements for SigTest, please see the SigTest
Setup page. Path: Setting Up the Test Environment page > SigTest Setup page.

• Keysight UXR Oscilloscope

• Keysight VNA (Vector Network Analyzer)

• Keyboard, qty = 1, (provided with the Keysight Infiniium oscilloscope)

• Mouse, qty = 1, (provided with the Keysight Infiniium oscilloscope)

• Keysight also recommends using a second monitor to view the test application

NOTE All test equipments require calibration to ensure accurate and repeatable 
results. The test equipments must be calibrated prior to, and if necessary, 
during the test procedure.

NOTE Keysight D9050USBC USB4v2 Compliance Test Application supports Keysight 
D9010AGGC Compliance Test Software Measurement Server for using multiple 
machines/PCs over a network as acquisition engines and processing engines 
in order to significantly enhance the test execution speed. 

To know more, please see the D9010AGGC product page on keysight.com 
(http://www.keysight.com/find/d9010aggc). 

https://www.usb.org/compliancetools#anchor_sigtest
https://www.mathworks.com/products/compiler/matlab-runtime.html
http://www.keysight.com/find/d9010aggc
http://www.keysight.com/find/d9010aggc
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Software

• The minimum version of Infiniium Oscilloscope Software (see the Keysight D9050USBC USB4v2 
Compliance Test Application Release Notes)

• Keysight D9050USBC USB4v2 Compliance Test Application software

Licensing information

Refer to the Data Sheet pertaining to USB4v2 Test Application to know about the licenses you must 
install along with other optional licenses. Visit “http://www.keysight.com/find/D9050USBC” and in 
the web page's Document Library tab, you may view the associated Data Sheet.

To procure a license, you require the Host ID information that is displayed in the Keysight License 
Manager application installed on the same machine where you wish to install the license. 

The licensing format for Keysight License Manager 6 differs from its predecessors. See “Installing the 
License Key" on page 19 to see the difference in installing a license key using either of the 
applications on your machine.

http://www.keysight.com/find/D9050USBC
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In This Book

This manual describes the tests that are performed by the USB4v2 Test Application in more detail.

• Chapter 2, “Installing the Test Application and Licenses” describes how to install the software 
and licenses for the USB4v2 Test Application software (if it was purchased separately).

• Chapter 3, “Preparing to Take Measurements” describes how to start the USB4v2 Test 
Application and gives a brief overview of its features.

• Chapter 4, “PAM-3 Signal Integrity Tests” contains the test procedures for PAM-3 physical layer 
tests.

• Chapter 6, “Appendix” provides detailed information about additional topics. 

See Also

The Keysight D9050USBC USB4v2 Compliance Test Application Methods of Implementation’s Online 
Help, which describes:

• Starting the USB4v2 Test Application

• Creating or Opening a Test Project

• Setting Up the Test Environment

• Selecting Tests

• Configuring Tests

• Verifying Physical Connections

• Running Tests

• Configuring Automation in the Test Application

• Viewing Results

• Viewing HTML Test Report

• Exiting the Test Application

• Additional Settings in the Test App
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2 Installing the Test Application 
and Licenses

Installing the Test Application  /  18
Installing the License Key  /  19

If you purchased the Keysight D9050USBC USB4v2 Compliance Test Application separately from 
your Infiniium oscilloscope, you must install the software and license key.
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Installing the Test Application

1 Make sure you have the minimum version of Infiniium Oscilloscope software (see the D9050USBC 
USB4v2 Test Application release notes). To ensure that you have the minimum version, select 
Help > About Infiniium... from the main menu.

2 To obtain the USB4v2 Test Application, go to Keysight website: 
“http://www.keysight.com/find/D9050USBC”.

3 In the web page's Trials & Licenses tab, click the Details and Download button to view instructions for 
downloading and installing the application software.

http://www.keysight.com/find/D9050USBC
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Installing the License Key

To procure a license, you require the Host ID information that is displayed in the Keysight License 
Manager application installed on the same machine where you wish to install the license.

Using Keysight License Manager 5

To view and copy the Host ID from Keysight License Manager 5:

1 Launch Keysight License Manager on your machine, where you wish to run the Test Application 
and its features.

2 Copy the Host ID that appears on the top pane of the application. Note that x indicates numeric 
values.

Figure 1 Viewing the Host ID information in Keysight License Manager 5

To install one of the procured licenses using Keysight License Manager 5 application,

1 Save the license files on the machine, where you wish to run the Test Application and its features.

2 Launch Keysight License Manager.

3 From the configuration menu, use one of the options to install each license file.

Figure 2 Configuration menu options to install licenses on Keysight License Manager 5

For more information regarding installation of procured licenses on Keysight License Manager 5, 
please refer to Keysight License Manager 5 Supporting Documentation.

https://www.keysight.com/main/redirector.jspx?action=ref&nid=-33002.0.00&lc=eng&cc=IN&ckey=2953922&cname=EDITORIAL&nfr=-33002.0.02
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Using Keysight License Manager 6

To view and copy the Host ID from Keysight License Manager 6:

1 Launch Keysight License Manager 6 on your machine, where you wish to run the Test Application 
and its features.

2 Copy the Host ID, which is the first set of alphanumeric value (as highlighted in Figure 3) that 
appears in the Environment tab of the application. Note that x indicates numeric values.

Figure 3 Viewing the Host ID information in Keysight License Manager 6
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To install one of the procured licenses using Keysight License Manager 6 application,

1 Save the license files on the machine, where you wish to run the Test Application and its features.

2 Launch Keysight License Manager 6.

3 From the Home tab, use one of the options to install each license file.

Figure 4 Home menu options to install licenses on Keysight License Manager 6

For more information regarding installation of procured licenses on Keysight License Manager 6, 
refer to Keysight License Manager 6 Supporting Documentation.

https://www.keysight.com/main/redirector.jspx?action=obs&nid=-33002.0.00&lc=eng&cc=IN&ckey=2994142&pubno=&ltype=LitStation&ctype=EDITORIAL&nfr=-33002.0.02
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3 Preparing to Take 
Measurements

Calibrating the Oscilloscope  /  24
Starting the USB4v2 Test Application  /  25
Setting Up the USB4v2 Test Application  /  28

Before running the automated tests, you should calibrate the oscilloscope and probe. After the 
oscilloscope and probe have been calibrated, you are ready to start the USB4v2 Test Application and 
perform the measurements.

NOTE Use USB-IF approved test fixtures only.
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Calibrating the Oscilloscope

If you have not already calibrated the oscilloscope, refer to the User Guide for the respective 
Oscilloscope you are using.

NOTE If the ambient temperature changes more than 5 degrees Celsius from the 
calibration temperature, internal calibration should be performed again. The 
delta between the calibration temperature and the present operating 
temperature is shown in the Utilities > Calibration menu.

NOTE If you switch cables between channels or other oscilloscopes, it is necessary to 
perform cable and probe calibration again. Keysight recommends that, once 
calibration is performed, you label the cables with the channel on which they 
were calibrated.
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Preparing to Take Measurements 3

Starting the USB4v2 Test Application

1 Ensure that the USB4v2 Device Under Test (DUT) is operating and set to desired test modes. To 
start the USB4v2 Test Application: From the Infiniium Oscilloscope's main menu, select 
Analyze > Automated Test Apps > D9050USBC USB4v2 Test App

Figure 5 USB4v2 Test Application default window

NOTE To launch the application on worker PCs in measurement server mode, please use the 
following Infiniium path: Analyze > Automated Test Apps > Measurement Server > 
D9050USBC USB4v2 Test App Measurer.

NOTE When launching the USB4v2 application for the first time - particularly if Infiniium Offline was 
launched beforehand, go to the Configure tab and set the Sampling Rate to the maximum 
supported rate of the oscilloscope.

For optimal configuration, it is recommended to launch the test application using USB4v2 app 
shortcut.
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To understand the functionality of the various features in the user interface of the test application, 
refer to the Keysight D9050USBC USB4v2 Compliance Test Application Online Help available in the 
Help menu.



Keysight D9050USBC USB4v2 Compliance Test Application Methods of Implementation 27

Preparing to Take Measurements 3

The task flow pane and the tabs in the main pane show the steps you take in running the automated 
tests:

Set Up Lets you identify and set up the test environment, including information about the device under 
test. The Test App includes relevant information in the final HTML report.

Select Tests Lets you select the tests you want to run. The tests are organized hierarchically so you can select all 
tests in a group. After tests are run, status indicators show which tests have passed, failed, or not 
been run, and there are indicators for the test groups.

Configure Lets you configure test parameters (for example, channels used in test, voltage levels, etc.).

Connect Shows you how to connect the oscilloscope to the device under test for the tests that are to be run.

Run Starts the automated tests. If the connections to the device under test need to be changed while 
multiple tests are running, the tests pause, show you how to change the connection, and wait for 
you to confirm that the connections have been changed before continuing.

Automate Lets you construct scripts of commands that drive execution of the application.

Results Contains more detailed information about the tests that have been run. You can change the 
thresholds at which marginal or critical warnings appear.

HTML Report Shows a compliance test report that can be printed.

NOTE In the Configure tab, the values for all such configuration parameters that are 
oscilloscope-dependent, will correspond to the oscilloscope model (DSOs or UXRs), where 
you are running the test application.
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Setting Up the USB4v2 Test Application

In order to run the electrical compliance tests on a USB4v2 DUT operating at a symbol rate of 25.6 
GBd and Symbol Type PAM3, please set up the USB4v2 Test Application to be able to view and select 
the required tests.

1 Start the USB4v2 Test Application. See “Starting the USB4v2 Test Application" on page 25.By 
default, the USB4v2 Test Application displays the Set Up tab when you start the application or 
launch a new/existing project.

2 In the Device Info section, please click the Device Setup button to open the Device Setup dialog box.

Figure 6 Device Setup dialog box
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3 In the Device Setup dialog box, please enter the Device Info details, and click OK.

Table 1  Device info parameters and description 

Device Info Parameter Description

Signal Type Select the required signal type. Currently, only PAM3 signal type is available for
selection.  

Symbol Rate Select the required symbol rate. Currently, only 25.6 GBd symbol rate is available
for selection. 

Test Groups Select the required test group viz., Tx, Rx RL, or LFPS.

Lanes Four lanes are available for selection, i.e., Lane A - TX1, Lane B - TX2, Lane C - RX1, and Lane D - 
RX2. Please select the lanes that need to be tested.

Preset User Defined Preset

If Transmitter Equalization tests are not run, the application will not be able to obtain the best preset 
automatically, instead it will use the User Defined Optimum Preset to run the Signal Integrity Tests. 
Please select the User defined Optimum Preset check box if you do not run the Transmitter 
Equalization tests, and require to use a predefined preset value to run the required Signal Integrity 
Tests. After selecting this check box, please navigate to the Configure tab, and manually select the 
required preset for each lane. 

Auto Best Preset

In order to configure the application to select the best preset automatically: 
1 Clear the User Defined Optimum Preset check box. 
2 Please select and run all or required Transmitter Equalization tests with the Best Preset test. 
3 Run the required Signal Integrity Tests. 

Please note, if all the PAM-3 Tests are selected and run together, the application will first run the 
Transmitter Equalization tests, then the Best Preset test to select the optimum preset (if the User 
Defined Optimum Preset check box is clear) followed by the Signal Integrity Tests. 
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4 In the Connection Info section, please click the Connection Setup button to open the Connection Setup 
dialog box.

Figure 7 Connection info section of the Set Up tab. 

Retimer Option If the DUT has a retimer connected, please enable the Retimer check box:

Following tests are enabled:

• Frequency Variation Training Tests:
• Init Frequency Variation Training
• Delta Frequency Variation Training 200ns
• Delta Frequency Variation Training 1000ns
• Overshoot Frequency Variation Training
• Steady State Frequency Variation Training

Link Type Please select one of the following link types: 

• 3xTxRx: This link type supports three transmit (Tx) and three receive (Rx) channels. It’s designed 
for high-bandwidth applications where both sending and receiving large amounts of data 
simultaneously is crucial.

• 3xTx:This configuration focuses on three transmit channels. It’s ideal for scenarios where the 
primary need is to send data out, such as in broadcasting or data upload-heavy applications.

• 3xRx: This setup features three receive channels, making it suitable for applications that require 
receiving large volumes of data, like data centers or download-heavy environments.

• Symmetric: This link type offers equal bandwidth for both transmitting and receiving data. It’s 
balanced and versatile, suitable for general-purpose applications where data flow in both 
directions is equally important.

De-embed/Embed Info Enable Cable Deembed

By selecting the Enable Cable Deembed check box, losses from fixture or DUT cable could be 
de-embeded. Use the Browse option to provide an S-parameter file for each lane under test. The 
S-parameter will be applied during waveform acquisition. If a transfer function file has not been 
generated prior to this, Infiniisim transfer function file will be generated at run time during waveform 
acquisition and applied to the live waveform. The cable de-embed feature is applicable to all the 
tests. 

SigTest / Infiniium

Please select either SigTest or Infiniium with which you wish to run the tests.

Device Info Parameter Description
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Figure 8 Connection Setup dialog box 

5 In the Connection Setup dialog box, please select Connection Type and Channel Selection for the 
Device Under Test (DUT) according to which the test list is displayed in the Select Tests tab. The 
available Connection Type is Single-Ended. The available Channel Selection options are Channel 1, 
Channel 3 and Channel 2, Channel 4. Click OK to save the changes and close the dialog box. 

6 In the Connection Info section of the Set Up tab, please click the SigTest Setup button to open the 
SigTest Setup dialog box. Please see the SigTest Setup page in the Online Help for more info.
Path: Online Help > Setting Up the Test Environment page > SigTest Setup page.

7 In the Connection Info section of the Set Up tab, please click the VNA Setup button to open the 
Connect to The Vector Network Analyzer (Keysight VNA) dialog box. Please see the Connect VNA page in 
the Online Help for more info.
Path: Online Help > Setting Up the Test Environment page > Connect VNA page.

8 Based on your choices under the Set Up tab, the Select Tests tab filters tests into test groups.

Figure 9 Selecting PAM3 tests for all symbol rates
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9 Under the Configure tab, you may modify the values for various configurable options associated 
with the compliance tests. By default, the USB4v2 Test Application sets the values of these 
options to the optimum value according to the standard specifications.

Figure 10 Configure options for USB4v2 tests
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10 Under the Connect tab, the USB4v2 Test Application displays a Connection Diagram along with a 
list of instructions. If you have already set up a physical connection, you may verify else connect 
the DUT with the Oscilloscope as shown under this tab. Note that during some test runs, the 
application may prompt you for a change in physical connection/setup.

Figure 11 Connection diagram and instructions 

11 Once you have performed steps 1 to 9, you are ready to run compliance tests on the USB4v2 
DUT. Additionally, you may configure/modify the run settings, automate options in the test 
application, and view, export, or print the test results and the HTML reports generated by the test 
application. Refer to the Keysight D9050USBC USB4v2 Compliance Test Application Online Help 
to know more about how to use the test application.
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4 PAM-3 Signal Integrity Tests

Best Preset  /  34
Transmitter Unit Interval Min/Max  /  36
Transmitter Level Mismatch  /  38
Steady State Voltage (V_SWING)  /  40
Transmitter ISI Margin  /  42
Signal-to-Noise and Distortion Ratio (SNDR)  /  44
Uncorrelated Jitter (UJ)  /  46
Uncorrelated Deterministic Jitter (UDJ)  /  48
Uncorrelated Deterministic Jitter Low Frequency (UDJ LF)  /  50
Even Odd (DCD) Jitter  /  52
Eye Height (Informative Test)  /  54
Eye Width (Informative Test)  /  56
SSC Down Spread Range (Max)  /  58
SSC Down Spread Range (Min)  /  60
SSC Down Spread Rate (Max)  /  62
SSC Down Spread Rate (Min)  /  64
SSC Phase Deviation  /  66
SSC Slew Rate  /  68
AC Common-Mode Output Voltage  /  70
Electrical Idle Output Voltage  /  72
Init Frequency Variation Training  /  75
Delta Frequency Variation Training 200 ns  /  78
Delta Frequency Variation Training 1000 ns  /  81
Overshoot Frequency Variation Training  /  84
Steady State Frequency Variation Training  /  87
Transmitter Return Loss Measurement (RL_DIFF) Test  /  90
Transmitter Integrated Return Loss Measurement  /  95
Receiver Return Loss Measurement (RL_DIFF)  /  100
Receiver Integrated Return Loss (IRL) Measurement  /  105

This chapter describes the normative and informative tests for PAM-3 Signal Integrity Tests. 
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Best Preset

Test Overview

This test analyzes the Transmitter Equalization tests to identify the best preset for the PAM-3 signal. 

Pass Limits

N/A (Not Applicable)

Test Reference

• USB4 Electrical Compliance Test Specification, section 3.3

Test Conditions

Figure 12 Selecting the best preset test

NOTE Best Preset test is available only when User Defined Optimum Preset 
check box in the Device Setup dialog box is not selected. 

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 13 Connection diagram for best preset test

Measurement Procedure

1 Identify the preset that obtains the lowest DDJ based on the results of the Transmitter Equalization 
tests, and update the info for each lane in the Configure tab. 

Pass Condition

NA (Not Applicable)

NOTE Please select the Best Preset test along with the required Transmitter 
Equalization Tests to allows the Best Preset tests to analyze and select the 
best preset for the Signal Integrity Tests.
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Transmitter Unit Interval Min/Max

Test Overview

This test confirms if the Transmitter Unit Interval of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 14 Selecting the unit interval test

Test Parameter Min Limit Max Limit

Unit Interval Min 39.0508 ps 39.0742 ps

Unit Interval Max 39.0508 ps 39.0742 ps

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 15 Connection diagram for the transmitter unit interval test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification. 

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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Transmitter Level Mismatch

Test Overview

This test confirms if the Transmitter Level Mismatch of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 16 Selecting the transmitter level mismatch test

Test Parameter Min Limit

Transmitter Level Mismatch 975.0 m

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 17 Connection diagram for the transmitter level mismatch test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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Steady State Voltage (V_SWING)

Test Overview

This test confirms if the Steady State Voltage (V_SWING) of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 18 Selecting the transmitter steady state voltage test

Test Parameter Min Limit Max Limit

Steady State Voltage (V_SWING) 390.00 mV 500.00 mV

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3



Keysight D9050USBC USB4v2 Compliance Test Application Methods of Implementation 41

Host / Device USB4 Transmitter Testing 4

Figure 19 Connection diagram for the transmitter steady state voltage test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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Transmitter ISI Margin

Test Overview

This test confirms if the Transmitter ISI Margin of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 20 Selecting the transmitter ISI margin test

Test Parameter Min Limit

Transmitter ISI Margin 11.50 dB

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 21 Connection diagram for the transmitter ISI margin test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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Signal-to-Noise and Distortion Ratio (SNDR)

Test Overview

This test confirms if the Signal-to-Noise and Distortion Ratio (SNDR) of the PAM-3 signal is within 
the USB4 v2.0 specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 22 Selecting the transmitter signal-to-noise and distortion ratio test

Test Parameter Min Limit

Signal-to-Noise and Distortion Ratio (SNDR) 32.50 dB

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 23 Connection diagram for the transmitter signal-to-noise and distortion ratio test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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Uncorrelated Jitter (UJ)

Test Overview

This test confirms if the Uncorrelated Jitter (UJ) of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 24 Selecting the transmitter uncorrelated jitter (UJ) test

Test Parameter Max Limit

Uncorrelated Jitter (UJ) 170.00 mUI pp

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 25 Connection diagram for the transmitter uncorrelated jitter (UJ) test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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Uncorrelated Deterministic Jitter (UDJ)

Test Overview

This test confirms if the Uncorrelated Deterministic Jitter (UDJ) of the PAM-3 signal is within the 
USB4 v2.0 specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 26 Selecting the transmitter uncorrelated deterministic jitter (UDJ) test

Test Parameter Max Limit

Uncorrelated Deterministic Jitter (UDJ) 75.00 mUI

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 27 Connection diagram for the transmitter uncorrelated deterministic jitter (UDJ) test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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Uncorrelated Deterministic Jitter Low Frequency (UDJ LF)

Test Overview

This test confirms if the Uncorrelated Deterministic Jitter Low Frequency (UDJ LF) of the PAM-3 
signal is within the USB4 v2.0 specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 28 Selecting the transmitter uncorrelated deterministic jitter low frequency (UDJ LF) test

Test Parameter Max Limit

Uncorrelated Deterministic Jitter Low Frequency (UDJ LF) 30.00 mUI

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 29 Connection diagram for the transmitter uncorrelated deterministic jitter low frequency (UDJ LF) test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).



4 Host / Device USB4 Transmitter Testing

52  Keysight D9050USBC USB4v2 Compliance Test Application Methods of Implementation

Even Odd (DCD) Jitter

Test Overview

This test confirms if the Even Odd Jitter of the PAM-3 signal is within the USB4 v2.0 specification 
limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 30 Selecting the transmitter even odd jitter test

Test Parameter Max Limit

Even Odd Jitter 20.00 mUI

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 31 Connection diagram for the transmitter even odd jitter test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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Eye Height (Informative Test)

Test Overview

This test evaluates the eye height of the PAM-3 signal.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification Section 
3.3)

Test Conditions

Figure 32 Selecting the eye height test

Test Parameter Max Limit

N/A N/A

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 33 Connection diagram for eye height test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Repeat the test for all remaining USB4 Transmitter Lanes. 

4 Obtains the eye-height test results from SigTest.

5 Reports the measured eye-height value as the measurement result.

Pass Condition

N/A - Reports the measured eye-height value as the measurement result.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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Eye Width (Informative Test)

Test Overview

This test evaluates the eye width of the PAM-3 signal.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification Section 
3.3)

Test Conditions

Figure 34 Selecting the eye width test

Test Parameter Max Limit

N/A N/A

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 35 Connection diagram for eye width test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Repeat the test for all remaining USB4 Transmitter Lanes. 

4 Obtains the eye-width test results from SigTest. 

5 Reports the measured eye-width value as the measurement result.

Pass Condition

N/A - Reports the measured eye-width value as the measurement result.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).



4 Host / Device USB4 Transmitter Testing

58  Keysight D9050USBC USB4v2 Compliance Test Application Methods of Implementation

SSC Down Spread Range (Max)

Test Overview

This test confirms if the SSC Down Spread Range (Max) of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 36 Selecting the transmitter SSC down spread range (max) test

Test Parameter Min Limit Max Limit

SSC Down Spread Range (Max) 200.00 m% 300.00 m%

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3



Keysight D9050USBC USB4v2 Compliance Test Application Methods of Implementation 59

Host / Device USB4 Transmitter Testing 4

Figure 37 Connection diagram for the transmitter SSC down spread range (max) test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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SSC Down Spread Range (Min)

Test Overview

This test confirms if the SSC Down Spread Range (Min) of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 38 Selecting the transmitter SSC down spread range (min) test

Test Parameter Min Limit Max Limit

SSC Down Spread Range (Min) 200.00 m% 300.00 m%

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Host / Device USB4 Transmitter Testing 4

Figure 39 Connection diagram for the transmitter SSC down spread range (min) test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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SSC Down Spread Rate (Max)

Test Overview

This test confirms if the SSC Down Spread Rate (Max) of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 40 Selecting the transmitter SSC down spread rate (max) test

Test Parameter Min Limit Max Limit

SSC Down Spread Rate (Max) 30.00 kHz 33.0 kHz

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Figure 41 Connection diagram for the transmitter SSC down spread rate (max) test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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SSC Down Spread Rate (Min)

Test Overview

This test confirms if the SSC Down Spread Rate (Min) of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 42 Selecting the transmitter SSC down spread rate (min) test

Test Parameter Min Limit Max Limit

SSC Down Spread Rate (Min) 30.00 kHz 33.0 kHz

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Figure 43 Connection diagram for the transmitter SSC down spread rate (min) test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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SSC Phase Deviation

Test Overview

This test confirms if the SSC Phase Deviation of the PAM-3 signal is within the USB4 v2.0 
specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 44 Selecting the transmitter SSC phase deviation test

Test Parameter Min Limit Max Limit

SSC Phase Deviation 2.50 ns 15.50 ns

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Figure 45 Connection diagram for the transmitter SSC phase deviation test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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SSC Slew Rate

Test Overview

This test confirms if the SSC Slew Rate of the PAM-3 signal is within the USB4 v2.0 specification 
limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 46 Selecting the SSC slew rate test

Test Parameter Max Limit

SSC Slew Rate 500.00 ppm/us

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Figure 47 Connection diagram for the transmitter SSC slew rate test

Measurement Procedure

1 Use the Best Preset that obtains the lowest DDJ based on the Transmitter Equalization tests or user 
preference in the Configure tab.

2 Run SigTest tool using corresponding preset waveform. No new signal acquisition is required in 
this test.

3 Check SigTest report for pass/fail status.

4 Repeat the test for all remaining USB4 Transmitter Lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE If Transmitter Equalization tests are not run, the application will not be 
able to obtain the Best Preset automatically, instead it will use the User 
Defined Optimum Preset to run the Signal Integrity Tests.

For more info, please see the Online Help > Setting Up the Test 
Environment page.

NOTE Scope intrinsic noise file shall be provided to SigTest with the same scope 
settings used for capturing the file with the selected preset configuration 
as described in Appendix C (USB4 Electrical Compliance Test 
Specification).
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AC Common-Mode Output Voltage

Test Overview

This test confirms if the AC Common-Mode Output Voltage of the PAM-3 signal is within the USB4 
v2.0 specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Figure 48 Selecting the AC common-mode output voltage test

Test Parameter Max Limit

AC Common-Mode Output Voltage 100.00 mVp-p

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Figure 49 Connection diagram for the transmitter AC common-mode output voltage test

Measurement Procedure

1 Set oscilloscope as:

• Bandwidth: 25 GHz

• Sampling Rate ≥ 80 GSa/s (while keeping acquisition record length of 500 µs)

• No CDR, no average, and no interpolation should be used.

• The signal vertical scaling must be optimized per preset (obtaining at least 80% of the vertical 
range).

2 Lane under test should transmit PRTS7 pattern, remaining lanes should be activated as 
aggressors transmitting PRTS19. SSC should be enabled during the test.

3 Activate device under test with maximum number of aggressor lanes configured as transmitters. 
Configure lane under test and aggressors according to Appendix A of the USB4 Electrical 
Compliance Test Specification.

4 Run SigTest tool.

5 Check SigTest report for pass/fail status.

6 Repeat the test for all remaining USB4 transmitter lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE Best Preset is the one that produces the least DDJ. 
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Electrical Idle Output Voltage

Test Overview

This test confirm if the Tx peak voltage while transmitting electrical idle is within USB4 v2.0 
Specification limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification, section 
3.3)

Test Conditions

Test Parameter Max Limit

Electrical Idle Output Voltage 20 mVp-p

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3
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Figure 50 Selecting the electrical idle output voltage test

Figure 51 Connection diagram for the transmitter electrical idle output voltage test
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Measurement Procedure

1 Set oscilloscope as: 

• Bandwidth: 25 GHz

• Sampling Rate ≥80 GSa/s (while keeping acquisition record length of 500 µs)

• No CDR, no average, and no interpolation should be used.

• The signal vertical scaling must be optimized per preset (obtaining at least 80% of the vertical 
range).

2 Configure DUT to electrical idle mode. 

3 Activate device under test with maximum number of aggressor lanes configured as transmitters 
(Configure lane under test and aggressors according to Appendix A of the USB4 Electrical 
Compliance Test Specification.

4 Performs compliance testing using SigTest. 

5 Reports the result values from SigTest and compares with compliance limits to report pass/fail.

6 Repeat the test for all remaining USB4 transmitter lanes.

Pass Condition

The results should be within the conformance limits as per the specification.
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Init Frequency Variation Training

Test Overview

This test confirms if the frequency variation during link training is within USB4 2.0 Specification limits

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification Section 
3.3)

Test Conditions

Test Parameter Min Limit Max Limit

Init Frequency Variation Training -300 ppm 300 ppm

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern “SQ224 - PRTS7 PAM3” or “SQ128 - PRTS7 PAM3”
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Figure 52 Selecting the init frequency variation training test

Figure 53 Connection diagram for the init frequency variation training test
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Measurement Procedure

1 Configure transmitter under test with maximum number of aggressor lanes configured as 
transmitters connected to 50 Ω termination. (Configure Lane under test and aggressors 
according to Appendix A)

2 For emulating link training set router assembly components as following:

• Configure router to transmit PRTS7 PAM3 pattern on all lanes. SSC modulation shall be 
disabled.

• Configure re-timer facing USB type-c connector to transmit SQ224 (if supported) or SQ128 (if 
SQ224 is not supported) on all lanes. Re-timer shall prevent the transition to “Forwarding 
state”.

3 Set oscilloscope as:

• Bandwidth: 25 GHz

• Sampling rate: 80 GSa/s; while keeping acquisition record length of 500 µs.

• No CDR, no average, and no interpolation to be used.

• Optimize the signal vertical scaling (obtaining at least 80% of the vertical range).

4 Initiate transition to “Forwarding state” on the re-timer facing USB type-c connector.

5 Capture the clock switch event over three stages: pre-clock switch, clock switch, and post-clock 
switch in a single waveform as depicted in Figure 54.

Figure 54 Frequency variation dynamics example

6 Perform measurement using SigTest tool.

7 Check SigTest report for pass/fail status.

8 Repeat above procedure 10 times. Use the worst case result as final.

9 Repeat the test for all the remaining lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE The de-embedding of the cable assembly connecting TP2 compliance test 
point to the Oscilloscope is done by the SigTest tool. Measured cable 
assembly s-parameters s4p file will be used for de-embedding in SigTest 
tool. No additional de-embedding is needed; see Appendix B of the CTS for 
correct network analyzer setup.
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Delta Frequency Variation Training 200 ns

Test Overview

This test confirms if the “delta frequency variation training 200 ns” is within USB4 2.0 specification 
limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification Section 
3.3)

Test Conditions

Test Parameter Max Limit

Delta Frequency Variation Training 200 ns 600 ppm

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern “SQ224 - PRTS7 PAM3” or “SQ128 - PRTS7 PAM3”



Keysight D9050USBC USB4v2 Compliance Test Application Methods of Implementation 79

Host / Device USB4 Transmitter Testing 4

Figure 55 Selecting the delta frequency variation training 200 ns test

Figure 56 Connection diagram for the delta frequency variation training 200 ns test
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Measurement Procedure

1 Configure transmitter under test with maximum number of aggressor lanes configured as 
transmitters connected to 50 Ω termination. (Configure Lane under test and aggressors 
according to Appendix A)

2 For emulating link training set router assembly components as following:

• Configure router to transmit PRTS7 PAM3 pattern on all lanes. SSC modulation shall be 
disabled.

• Configure re-timer facing USB type-c connector to transmit SQ224 (if supported) or SQ128 (if 
SQ224 is not supported) on all lanes. Re-timer shall prevent the transition to “Forwarding 
state”.

3 Set oscilloscope as:

• Bandwidth: 25 GHz

• Sampling rate: 80 GSa/s; while keeping acquisition record length of 500 µs.

• No CDR, no average, and no interpolation to be used.

• Optimize the signal vertical scaling (obtaining at least 80% of the vertical range).

4 Initiate transition to “Forwarding state” on the re-timer facing USB type-c connector.

5 Capture the clock switch event over three stages: pre-clock switch, clock switch, and post-clock 
switch in a single waveform as depicted in Figure 54.

Figure 57 Frequency variation dynamics example

6 Perform measurement using SigTest tool.

7 Check SigTest report for pass/fail status.

8 Repeat above procedure 10 times. Use the worst case result as final.

9 Repeat the test for all the remaining lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE The de-embedding of the cable assembly connecting TP2 compliance test 
point to the Oscilloscope is done by the SigTest tool. Measured cable 
assembly s-parameters s4p file will be used for de-embedding in SigTest 
tool. No additional de-embedding is needed; see Appendix B of the CTS for 
correct network analyzer setup.
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Delta Frequency Variation Training 1000 ns

Test Overview

This test confirms if the “delta frequency variation training 1000 ns” is within USB4 2.0 specification 
limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification Section 
3.3)

Test Conditions

Test Parameter Max Limit

Delta Frequency Variation Training 1000 ns 900 ppm

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern “SQ224 - PRTS7 PAM3” or “SQ128 - PRTS7 PAM3”
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Figure 58 Selecting the delta frequency variation training 1000 ns test

Figure 59 Connection diagram for the delta frequency variation training 1000 ns test
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Measurement Procedure

1 Configure transmitter under test with maximum number of aggressor lanes configured as 
transmitters connected to 50 Ω termination. (Configure Lane under test and aggressors 
according to Appendix A)

2 For emulating link training set router assembly components as following:

• Configure router to transmit PRTS7 PAM3 pattern on all lanes. SSC modulation shall be 
disabled.

• Configure re-timer facing USB type-c connector to transmit SQ224 (if supported) or SQ128 (if 
SQ224 is not supported) on all lanes. Re-timer shall prevent the transition to “Forwarding 
state”.

3 Set oscilloscope as:

• Bandwidth: 25 GHz

• Sampling rate: 80 GSa/s; while keeping acquisition record length of 500 µs.

• No CDR, no average, and no interpolation to be used.

• Optimize the signal vertical scaling (obtaining at least 80% of the vertical range).

4 Initiate transition to “Forwarding state” on the re-timer facing USB type-c connector.

5 Capture the clock switch event over three stages: pre-clock switch, clock switch, and post-clock 
switch in a single waveform as depicted in Figure 54.

Figure 60 Frequency variation dynamics example

6 Perform measurement using SigTest tool.

7 Check SigTest report for pass/fail status.

8 Repeat above procedure 10 times. Use the worst case result as final.

9 Repeat the test for all the remaining lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE The de-embedding of the cable assembly connecting TP2 compliance test 
point to the Oscilloscope is done by the SigTest tool. Measured cable 
assembly s-parameters s4p file will be used for de-embedding in SigTest 
tool. No additional de-embedding is needed; see Appendix B of the CTS for 
correct network analyzer setup.
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Overshoot Frequency Variation Training

Test Overview

This test confirms if the “overshoot frequency variation training” is within USB4 2.0 specification 
limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification Section 
3.3)

Test Conditions

Test Parameter Max Limit

Overshoot Frequency Variation Training 600 ppm

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern “SQ224 - PRTS7 PAM3” or “SQ128 - PRTS7 PAM3”
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Figure 61 Selecting the overshoot frequency variation training test

Figure 62 Connection diagram for the overshoot frequency variation training test
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Measurement Procedure

1 Configure transmitter under test with maximum number of aggressor lanes configured as 
transmitters connected to 50 Ω termination. (Configure Lane under test and aggressors 
according to Appendix A)

2 For emulating link training set router assembly components as following:

• Configure router to transmit PRTS7 PAM3 pattern on all lanes. SSC modulation shall be 
disabled.

• Configure re-timer facing USB type-c connector to transmit SQ224 (if supported) or SQ128 (if 
SQ224 is not supported) on all lanes. Re-timer shall prevent the transition to “Forwarding 
state”.

3 Set oscilloscope as:

• Bandwidth: 25 GHz

• Sampling rate: 80 GSa/s; while keeping acquisition record length of 500 µs.

• No CDR, no average, and no interpolation to be used.

• Optimize the signal vertical scaling (obtaining at least 80% of the vertical range).

4 Initiate transition to “Forwarding state” on the re-timer facing USB type-c connector.

5 Capture the clock switch event over three stages: pre-clock switch, clock switch, and post-clock 
switch in a single waveform as depicted in Figure 54.

Figure 63 Frequency variation dynamics example

6 Perform measurement using SigTest tool.

7 Check SigTest report for pass/fail status.

8 Repeat above procedure 10 times. Use the worst case result as final.

9 Repeat the test for all the remaining lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE The de-embedding of the cable assembly connecting TP2 compliance test 
point to the Oscilloscope is done by the SigTest tool. Measured cable 
assembly s-parameters s4p file will be used for de-embedding in SigTest 
tool. No additional de-embedding is needed; see Appendix B of the CTS for 
correct network analyzer setup.
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Steady State Frequency Variation Training

Test Overview

This test confirms if the “steady state frequency variation training” is within USB4 2.0 specification 
limits.

Pass Limits

Test Reference

• USB4v2 App Specification, version 1.00 (USB4 Electrical Compliance Test Specification Section 
3.3)

Test Conditions

Test Parameter Min Limit Max Limit

Steady State Frequency Variation Training -300 ppm 300 ppm

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern “SQ224 - PRTS7 PAM3” or “SQ128 - PRTS7 PAM3”
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Figure 64 Selecting the steady state frequency variation training test

Figure 65 Connection diagram for the steady state frequency variation training test
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Measurement Procedure

1 Configure transmitter under test with maximum number of aggressor lanes configured as 
transmitters connected to 50 Ω termination. (Configure Lane under test and aggressors 
according to Appendix A)

2 For emulating link training set router assembly components as following:

• Configure router to transmit PRTS7 PAM3 pattern on all lanes. SSC modulation shall be 
disabled.

• Configure re-timer facing USB type-c connector to transmit SQ224 (if supported) or SQ128 (if 
SQ224 is not supported) on all lanes. Re-timer shall prevent the transition to “Forwarding 
state”.

3 Set oscilloscope as:

• Bandwidth: 25 GHz

• Sampling rate: 80 GSa/s; while keeping acquisition record length of 500 µs.

• No CDR, no average, and no interpolation to be used.

• Optimize the signal vertical scaling (obtaining at least 80% of the vertical range).

4 Initiate transition to “Forwarding state” on the re-timer facing USB type-c connector.

5 Capture the clock switch event over three stages: pre-clock switch, clock switch, and post-clock 
switch in a single waveform as depicted in Figure 54.

Figure 66 Frequency variation dynamics example

6 Perform measurement using SigTest tool.

7 Check SigTest report for pass/fail status.

8 Repeat above procedure 10 times. Use the worst case result as final.

9 Repeat the test for all the remaining lanes.

Pass Condition

The results should be within the conformance limits as per the specification.

NOTE The de-embedding of the cable assembly connecting TP2 compliance test 
point to the Oscilloscope is done by the SigTest tool. Measured cable 
assembly s-parameters s4p file will be used for de-embedding in SigTest 
tool. No additional de-embedding is needed; see Appendix B of the CTS for 
correct network analyzer setup.
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Transmitter Return Loss Measurement (RL_DIFF) Test

Test Overview

The objective of this test is to confirm that the Transmitter Return Loss Measurement (RL_DIFF) of a 
USB4v2 device is less than the maximum limit.

Test Pass Requirement

NOTE When running the Test App on a 2-Channel Oscilloscope, the Select Tests 
tab shall display tests pertaining to either Lane 0 only or to Lane 1 only.
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Test Setup 

1 For the physical connections between the DUT & the Oscilloscope, see the connection diagrams 
in Figure 67 and Figure 68.

Figure 67 Tx Return loss test setup with Tx SMA test fixture connected to VNA

Figure 68 Tx Return loss test setup with Tx SMA test fixture connected to the scope
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2 In the Set Up tab, please connect VNA in the Tx app.

3 Prior calibration, setup Network Analyzer with following sweep settings:

• Frequency range of 10 MHz to 20 GHz

• IF BW of 1 kHz 

• At least 2000 points

• Impedance 85 ohm differential

• Define the Topology to Bal using VNA Port 1 and Port 3

NOTE Ensure that the VNA firmware revision is A.17.25.05 or higher to be compat-
ible with the return loss test automation. 
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4 Run calibration on the network analyzer and test cables using a 2-port electronic kit (ECal). Save 
the Cal file. 

5 In the Select test tab, select the Tx Return Loss Measurement and set the parameters in the 
Configure tab as shown in the figure below. 

6 The test application:

• sets USB4ETT Tool Usage Mode, 

• commands VNA to measure Tx Return Loss in S2P, 

• commands the scope to save the PRTS7 waveform from the DUT,

• and compiles result using SigTest. 

NOTE Please note that no gating setup is required for SMA fixture.



4 Host / Device USB4 Transmitter Testing

94  Keysight D9050USBC USB4v2 Compliance Test Application Methods of Implementation

Test Procedure

1 Choose a supported USB4 speed to start with.

2 The test application sets USB4ETT tool to configure the DUT transmitter to output PRTS7 on all 
the required lanes. 

3 Connect the channel 1 and 3 of the scope to the required lanes on the test fixture, configure the 
test pattern to PRTS7, and capture the waveform.

4 Connect the required lanes to the Network Analyzer and capture the S2P file.

5 Measure the Differential Return Loss using the S2P file and the PRTS7 waveform, and compile 
the result using SigTest.

6 If Differential Return Loss violates the above requirement, then the result is Fail.

7 Repeat the test for all remaining USB4 lanes.

Expected / Observable Results

If Differential Return Loss violated the specified requirement, then Fail.

Test References

See USB4 Specification Version 2.00 Gen4, Section 3.3
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Transmitter Integrated Return Loss Measurement

Test Overview

The objective of this test is to confirm that the Transmitter Integrated Return Loss Measurement (IRL) 
of a USB4v2 device is less than the maximum limit.

Test Pass Requirement

NOTE When running the Test App on a 2-Channel Oscilloscope, the Select Tests 
tab shall display tests pertaining to either Lane 0 only or to Lane 1 only.
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Test Setup 

1 For the physical connections between the DUT & the Oscilloscope, see the connection diagrams 
in Figure 69 and Figure 70.

Figure 69 Tx Integrated return loss test setup with Tx SMA test fixture connected to VNA

Figure 70 Tx Integrated return loss test setup with Tx SMA test fixture connected to the scope
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2 In the Set Up tab, please connect VNA in the Tx app.

3 Prior calibration, setup Network Analyzer with following sweep settings:

• Frequency range of 10 MHz to 20 GHz

• IF BW of 1 kHz 

• At least 2000 points

• Impedance 85 ohm differential

• Define the Topology to Bal using VNA Port 1 and Port 3

NOTE Ensure that the VNA firmware revision is A.17.25.05 or higher to be compat-
ible with the return loss test automation. 
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4 Run calibration on the network analyzer and test cables using a 2-port electronic kit (ECal). Save 
the Cal file. 

5 In the Select test tab, select the Tx Integrated Return Loss Measurement and set the parameters 
in the Configure tab as shown in the figure below. 

6 The test application:

• sets USB4ETT Tool Usage Mode, 

• commands VNA to measure Tx Integrated Return Loss in S2P, 

• commands the scope to save the PRTS7 waveform from the DUT,

• and compiles result using SigTest. 

NOTE Please note that no gating setup is required for SMA fixture.
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Test Procedure

1 Choose a supported USB4 speed to start with.

2 The test application sets USB4ETT tool to configure the DUT transmitter to output PRTS7 on all 
the required lanes. 

3 Connect the channel 1 and 3 of the scope to the required lanes on the test fixture, configure the 
test pattern to PRTS7, and capture the waveform.

4 Connect the required lanes to the Network Analyzer and capture the S2P file.

5 Measure the Transmitter Integrated Return Loss (IRL) using the S2P file and the PRTS7 
waveform, and compile the result using SigTest.

6 If Integrated Return Loss (IRL) violates the above requirement, then the result is Fail.

7 Repeat the test for all remaining USB4 lanes.

Expected / Observable Results

If Transmitter Integrated Return Loss (IRL) violated the specified requirement, then Fail.

Test References

See USB4 Specification Version 2.00 Gen4, Section 3.3
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Receiver Return Loss Measurement (RL_DIFF)

Test Overview

The objective of this test is to confirm that the Receiver Return Loss Measurement (RL_DIFF) of a 
USB4v2 device is less than the maximum limit.

Test Pass Requirement

NOTE When running the Test App on a 2-Channel Oscilloscope, the Select Tests 
tab shall display tests pertaining to either Lane 0 only or to Lane 1 only.
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Test Setup 

1 For the physical connections, please see the connection diagram in Figure 71.

Figure 71 Rx Return loss test setup with SMA test fixture connected to VNA
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2 In the Set Up tab, please connect VNA in the Tx app.

3 Prior calibration, setup Network Analyzer with following sweep settings:

• Frequency range of 10 MHz to 20 GHz

• IF BW of 1 kHz 

• At least 2000 points

• Impedance 85 ohm differential

• Define the Topology to Bal using VNA Port 1 and Port 3

NOTE Ensure that the VNA firmware revision is A.17.25.05 or higher to be compat-
ible with the return loss test automation. 
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4 Run calibration on the network analyzer and test cables using a 2-port electronic kit (ECal). Save 
the Cal file. 

5 In the Select test tab, select the Rx Return Loss Measurement and set the parameters in the 
Configure tab as shown in the figure below. 

6 The test application:

• sets USB4ETT Tool Usage Mode, 

• commands VNA to measure Rx Return Loss in S2P, 

• and compiles result using SigTest. 

NOTE Please note that no gating setup is required for SMA fixture.
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Test Procedure

1 Choose a supported USB4 speed to start with.

2 The test application sets USB4ETT tool to configure the DUT transmitter to output PRTS7 on all 
the required lanes. 

3 Connect the required lanes to the Network Analyzer and capture the S2P file.

4 Measure the Receiver Return Loss using the S2P file, and compile the result using SigTest.

5 If Receiver Return Loss violates the above requirement, then the result is Fail.

6 Repeat the test for all remaining USB4 lanes.

Expected / Observable Results

If Receiver Return Loss violated the specified requirement, then Fail.

Test References

See USB4 Specification Version 2.00 Gen4, Section 3.3
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Receiver Integrated Return Loss (IRL) Measurement

Test Overview

The objective of this test is to confirm that the Receiver Integrated Return Loss (IRL) Measurement of 
a USB4v2 device is less than the maximum limit.

Test Pass Requirement

IRL ≤ -13.5 dB

Test Setup 

1 For the physical connections, please see the connection diagram in Figure 72.

Figure 72 Rx Integrated Return Loss test setup with Tx SMA test fixture connected to VNA

NOTE When running the Test App on a 2-Channel Oscilloscope, the Select Tests 
tab shall display tests pertaining to either Lane 0 only or to Lane 1 only.
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2 In the Set Up tab, please connect VNA in the Tx app.

3 Prior calibration, setup Network Analyzer with following sweep settings:

• Frequency range of 10 MHz to 20 GHz

• IF BW of 1 kHz 

• At least 2000 points

• Impedance 85 ohm differential

• Define the Topology to Bal using VNA Port 1 and Port 3

NOTE Ensure that the VNA firmware revision is A.17.25.05 or higher to be compat-
ible with the return loss test automation. 
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4 Run calibration on the network analyzer and test cables using a 2-port electronic kit (ECal). Save 
the Cal file. 

5 In the Select test tab, select the Tx Return Loss Measurement and set the parameters in the 
Configure tab as shown in the figure below. 

6 The test application:

• sets USB4ETT Tool Usage Mode, 

• commands VNA to measure Rx Integrated Return Loss in S2P, 

• and compiles result using SigTest. 

NOTE Please note that no gating setup is required for SMA fixture.
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Test Procedure

1 Choose a supported USB4 speed to start with.

2 The test application sets USB4ETT tool to configure the DUT transmitter to output PRTS7 on all 
the required lanes. 

3 Connect the required lanes to the Network Analyzer and capture the S2P file.

4 Measure the Receiver Integrated Return Loss using the S2P file, and compile the result using 
SigTest.

5 If Receiver Integrated Return Loss violates the above requirement, then the result is Fail.

6 Repeat the test for all remaining USB4 lanes.

Expected / Observable Results

If Receiver Integrated Return Loss violated the specified requirement, then Fail.

Test References

See USB4 Specification Version 2.00 Gen4, Section 3.3
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5 PAM-3 Equalization Tests

Transmitter Equalization  /  110

This chapter describes the PAM-3 Equalization Tests. 
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Transmitter Equalization 

Test Overview

This test evaluates the Transmitter Equalization (P1, P2,... to P41) of the PAM-3 signal.

The transmitter equalization test list is as follows:

1 Transmitter Equalization (P1)

2 Transmitter Equalization (P2)

3 Transmitter Equalization (P3)

4 Transmitter Equalization (P4)

5 Transmitter Equalization (P5)

6 Transmitter Equalization (P6)

7 Transmitter Equalization (P7)

8 Transmitter Equalization (P8)

9 Transmitter Equalization (P9)

10 Transmitter Equalization (P10)

11 Transmitter Equalization (P11)

12 Transmitter Equalization (P12)

13 Transmitter Equalization (P13)

14 Transmitter Equalization (P14)

15 Transmitter Equalization (P15)

16 Transmitter Equalization (P16)

17 Transmitter Equalization (P17)

18 Transmitter Equalization (P18)

19 Transmitter Equalization (P19)

20 Transmitter Equalization (P20)

21 Transmitter Equalization (P21)

22 Transmitter Equalization (P22)

23 Transmitter Equalization (P23)

24 Transmitter Equalization (P24)

25 Transmitter Equalization (P25)

26 Transmitter Equalization (P26)

27 Transmitter Equalization (P27)

28 Transmitter Equalization (P28)

29 Transmitter Equalization (P29)

30 Transmitter Equalization (P30)

31 Transmitter Equalization (P31)

32 Transmitter Equalization (P32)

33 Transmitter Equalization (P33)

34 Transmitter Equalization (P34)

35 Transmitter Equalization (P35)

36 Transmitter Equalization (P36)

37 Transmitter Equalization (P37)

38 Transmitter Equalization (P38)
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39 Transmitter Equalization (P39)

40 Transmitter Equalization (P40)

41 Transmitter Equalization (P41)

Pass Limits

Table 2  Transmitter equalization preset table * **(USB4 Specification, Section 3.3.1)

Preset C[-2] C[-1] C[0] C[1]

0 0 0 1 0

1 0 0 0.95 -0.05

2 0 0 0.9 -0.1

3 0 0.85 -0.15

4 0 -0.05 0.95 0

5 0 -0.05 0.9 -0.05

6 0 -0.05 0.85 -0.1

7 0 -0.05 0.8 -0.15

8 0 -0.1 0.9 0

9 0 -0.1 0.85 -0.05

10 0 -0.1 0.8 -0.1

11 0 -0.1 0.75 -0.15

12 0 -0.15 0.85 0

13 0 -0.15 0.8 -0.05

14 0 -0.15 0.75 -0.1

15 0 -0.15 0.7 -0.15

16 0.025 -0.15 0.825 0

17 0.025 -0.15 0.775 -0.05

18 0.025 -0.15 0.725 -0.1

19 0.025 -0.15 0.675 -0.15

20 0 -0.2 0.8 0

21 0 -0.2 0.75 -0.05

22 0 -0.2 0.7 -0.1

23 0 -0.2 0.65 -0.15

24 0.025 -0.2 0.775 0

25 0.025 -0.2 0.725 -0.05
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• *For low swing mode (presets 40-41 only) the transmitter swing attenuation requirement is 
6±1dB.

• **For both low and full swing modes the tolerance of the normalized coefficients shall be of 
±0.015 for C[-2] and of ±0.025 for C[-1], C[0], and C[1] coefficients.

Test Reference

• USB4 Electrical Compliance Test Specification, section 3.3

Test Conditions

26 0.025 -0.2 0.675 -0.1

27 0.025 -0.2 0.625 -0.15

28 0.05 -0.2 0.75 0

29 0.05 -0.2 0.7 -0.05

30 0.05 -0.2 0.65 -0.1

31 0.05 -0.2 0.6 -0.15

32 0 -0.25 0.75 0

33 0 -0.25 0.7 -0.05

34 0.025 -0.25 0.725 0

35 0.025 -0.25 0.675 -0.05

36 0.05 -0.25 0.7 0

37 0.05 -0.25 0.65 -0.05

38 0.075 -0.25 0.675 0

39 0.075 -0.25 0.625 -0.05

40 0 -0.1 0.4 0

41 0 0 0.5 0

Preset C[-2] C[-1] C[0] C[1]

Test Parameter Condition

Signal Type PAM3

Symbol Rate 25.6 GBd

Test Pattern  PRTS7 PAM3



Keysight D9050USBC USB4v2 Compliance Test Application Methods of Implementation 113

Host / Device USB4 Transmitter Testing 5

Figure 73 Selecting the transmitter equalization test

Figure 74 Connection diagram for transmitter equalization test
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Measurement Procedure

1 Lane under test should transmit PRTS7 pattern, remaining lanes should be activated as 
aggressors transmitting PRTS19. SSC should be enabled during the test.

2 Activate device under test with maximum number of aggressor lanes configured as transmitters. 
Configure lane under test and aggressors according to Appendix A of the USB4 Electrical 
Compliance Test Specification.

3 Set Oscilloscope as:

• Bandwidth: 25 GHz

• Sampling rate ≥ 80 GSa/s (while keeping acquisition record length of 500 µs)

• No CDR, no average, and no interpolation should be used.

• The signal vertical scaling must be optimized per preset (obtaining at least 80% of the vertical 
range)

4 Capture the differential output signal with all presets one by one (total 42 waveforms). Record the 
oscilloscope vertical scaling setting (voltage/div) for each preset, it will be used for further scope 
intrinsic noise measurement as described in Appendix C of the USB4 Electrical Compliance Test 
Specification.

5 Run SigTest tool.

6 Check SigTest report for pass/fail status. All presets must be passing.

7 Repeat the test for all remaining USB4 transmitter lanes

8 In case more than one oscilloscope differential channel pair is used, please repeat the 
oscilloscope vertical scale tuning (voltage/div) and recording for each preset.

Pass Condition

NA (Not Applicable)
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